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O SOP 505 -
9.0 PROCEDURE

9.1 General:
Before operating the instrument for the first time, it is required that the analyst
should familiarize him- or herself with the operating controls and other aspects of
the analysis. Standard Operating Procedure (SOP)} and the PE Plasma Operation
Manual should be studied. Proficiency will be mandated of all analysts performing
analyses.

9.2 Sample Handling:

9.2.1 Collection:
All samples received and handled by this section will meet the requirements of the
Policy and Procedure Manual of the Water Quality Lab pertaining to handling and
preservation criteria.

Samples will be logged by the Sample Custodian and assigned a unique log
number. Pertinent information, i.e. location, date and time of collection, collector's -
name, sample type, date received by this section, person's name receiving the
sample, preservation used, and any special remarks concerning the sample wilt be
entered into the computer.

o

A batch number will be assigned by this section. All batches will be numbered with
reference to protocol and year, for example pretreatment batches will be assigned
PRE010102, representing the date prepped Jan 1, 2002.

9.2.2 Preservation and Preparation:
All samples will be prepared following Spectroscopy's Standard Operating
Procedures Sample Preparation Manual. Samples will be preserved with 2.5 ml
HNQO3 prior to admitting to lab. [t will be the responsibility of sample custodian to
check for pH. See QA Manual Section 1.0.

9.2.3 Storage:
Samples that may have legal ramifications due to not being within regulatory
compliance limits are to be stored in a secure area but for no longer than their
allowed holding times. Confer with the supervisor before discarding any samples.

9.2.4 Holding time:
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All samples will be stored in the spectroscopy refrigerator until samples are
prepped. Analysis will be performed within the time specified in the protocol, not
to be held longer than 3 months for metal analyses.

9.3 Functions of Controls and Display of ICP Instrument

9.3.1 Checking Status:
The system informs you of the current status of the instrument in the following
ways:

! Instrument Diagnostics windows: This window displays information about the
spectrometer environment, spectrometer status, detector status, and plasma
generator status. To open the Instrument Diagnostics window: In the System

menu, click on Diagnostics. Click on the Update button in this window to update
the information. '

! System Monitor status icons: The icons in the System Monitor window give a
graphical representation of the current condition of the instrument. To open the
System Monitor window: In the System menu, click on System Monitor.

! Error Messages: Error messages are displayed in the Message Log. To view the
message log: In the System menu, click on Message Log.

! Indicator Lights: The indicator lights on the front of the instrument (Plasma On,
System Power, and System Ready) indicate general operating status.

9.3.2 System Monitor Status Icons:
To open the System Monitor windows:
< In the System menu, click on System Monitor. See Figure 9.1.

Icon Color Meaning
Green The system component is powered on.

Yellow For the plasma torch icon, this indicates that the ignition
process has started. For other icons, yellow indicates a
caution status. A problem has occurred within this part of
the system. Read the Message Log for more details. This
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problem requires attention since it may eventually cause the
system to shut down.

Red A problem has occurred within this part of the system. Read
the Message Log for more details. This problem needs to
be fixed before you can operate the instrument.

Gray This part of the system is functioning properly.
9.3.3 Information Display Windows: ,
! Spectra Display Window: View spectra and associated information, as each
spectrum is generated during an analysis.

! The Results Display Window: View a list of the analytical results as they are
generated from an analysis.

! Calibration Display Window: View the calibration curves
< during Method Development to ascertain an appropriate curve fitting algorithm
< during routine analysis to pravide a visual check of the calibrations.

! Examine Spectra Window: View spectra that have been saved to a data set so
that you can:

< modify method parameters directly from the Examine window
< manipulate the appearance of the spectra to aid in method development and
set up spectral displays for reports.

! Analytical Sequence Window: View the samples listed according to the analytical
sequence.

! Autosampler Loading List: View the samples listed according to the autosampler
location number.

9.4 System Initialization and Setup:

9.4.1 Interlocks:
Interlocks are designed to ensure operator safety and protect the instrument form
damage. The main system interlocks are described below.

The following interlocks must be satisfied in order to ignite the plasma. If any of
these interlocks is interrupted while the plasma is on, the plasma will automatically
be shut down.
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' The front and side doors on the sample compartment must be closed before you
can ignite the plasma.

! Argon pressures for the torch must be correct.
! Cooling water must be flowing to the RF coil.

The following interlocks are for the detectors. If any of these interlocks is
interrupted while the system is operating, the detectors will be shut down.

! The argon purge for the detectors and nitrogen purge for the spectrometer optics,
monitored by flow switches, must be functioning properly.

! The temperature of the optics housing must be 36-40C.
! The temperature of the detector must be less than -30C.

9.4.2 Initialization Steps:
The Main Instrument switch is used to turn on the spectrometer (and is normally
left on). When the switch is first turned on, a system clock checks fo see how long
the instrument has been off. Based on this time, the system determines what
startup routines must be carried out before the instrument can be operated and
displays the wait time on the computer (13 to 73 minutes). The software sends
instructions to the instrument for the required initialization sequence. If the
software is not on initially, the instrument will wait up to 10 minutes for instructions;
otherwise it carries out its startup routine independently. The RF generator, which
is switched on by the RF generator standby switch, takes about one minute to
warm up.

Once the plasma has been ignited, you should wait one hour for the system to
stabilize before running samples.

The spectrometer initialization sequence is as follows:

1. As soon as the Main Instrument switch is turned on, the spectrometer begins a
high argon and high nitrogen purge. If the instrument has been off for more that
thirty minutes, the instrument begins a Acold start=, followed by a Ahot start=. If
the instrument had been off for less than thirty minutes (and was previously

in the ready state), the instrument begins a Ahot start=.
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2. The Acold start= initialization sequence lasts 60 minutes. During this
sequence, the instrument:
a. runs a high nitrogen purge of the optical system for 60 minutes.
b. checks to make sure that the thermal plenum is at the required temperature
(36-40C) and checks functioning of slit motor and transfer optics motors.c.
checks the temperature inside the optics system.

3. The Ahot start= initialization sequence lasts 13 minutes. During this sequence,
the instrument:
a. performs a 10-minute high argon and high nitrogen purge and checks the
slit, and transfer optics motors.
b. turns on the cooling water, the thermoelectric coolers for the detectors, and
then turns on the power to the detectors and switches to a low argon and
nitrogen purge.
24 begins monitoring temperature of the detectors.
d. checks for proper functioning of the shutter, checks for dark current, turns on
the mercury lamp and checks the mercury peak.

4. The spectrometer sends a >system ready message to the computer. Provided
the software and the RF generator are on, the green System Ready indicator
on the front of the instrument lights up.

9.4.3 Hardware Setup:
The following hardware settings are controlied by the software.
RF Power. Power levels can be adjusted in 5-watt increments. Recommended
setting 1450 watts.

Plasma and auxiliary argon flow rates: Flow rates can be automated during the
analysis with specific flow rates for each element if desired. Plasma argon in
adjustable in 1 L/min increments. Auxiliary argon is adjustable in 0.1 L/min
increments. Recommended setting 0.5 L/min Auxiliary Flow.
Recommended setting 15 L/min Plasma Flow.

Nebulizer argon flow rate: The flow rate is automatically controlled using a mass
flow controller in .001 L/min increments. Recommended setting 0.75 L/min.

Pump rate: By specifying the desired flow rate (adjustable in 0.1 mL/min
increments) and the tubing diameter, the software calculates the pump speed. A
fast pump speed can be set for the read delay or rinse cycle. Recommended
setting 1.5 mL/min.
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Equilibration Time: Recommended setting 15 sec.

Nitrogen purge rate: A high or low rate can be specified.

Mercury wavelength recalibration: An automatic recalibration can be specified to
occur at defined intervals (from every 3 minutes to 999 hrs).

Dark current measurement: A shutter under software-control can be closed to
block light from reaching the detector in order to measure dark current.

The software also has a built-in optimization function for plasma viewing. The
area of the plasma viewed by the optical system can be adjusted horizontally (in
0.4 mm steps) and vertically (in 1 mm steps) using a moveable transfer optic. A
software function lets you automatically adjust the horizontal alignment.

9.5 Setting Up the Instrument:

9.5.1 Checking the System:
Proper setup and routine maintenance are required to keep your instrument in
proper working condition so that you will get acceptable performance.

! Exhaust Vent
< Check that your vent system is switched on, is working properly, and is not blocked.

! Argon Supply

< Be sure that an adequate supply of argon is available and is connected to the
system.

< Check that the cylinder valve is open and the regulator for the argon outlet
pressure is set within the following range: 70-120 psig.

< Check for leaks at the gas connections on the back of the instrument.

! Nitrogen purge gas supply

< Be sure that an adequate supply of nitrogen is available and connected to the
system.

< Check that the cylinder valve is open and the regulator for the nitrogen outlet
pressure is set within this range: 30-120 psig.

< Check for leaks at the gas connections on the back of the instrument.
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! Shear gas supply
< For compressed air, check that the shut-off valve on the air dryer filter is open and
the pressure for the air compressor is set within this range: 75-100 psig.
< Check for leaks at the gas connections on the back of the instrument.

! Cooling water supply

< Check that the cooling water supply is connected to the back of the instrument.

< Using a chiller, check the electrical connections. Check that the External Pressure
Reducer has been set to 45 +/-5 psig. Be sure the chiller is turned on and has
been filled. Periodically check the liquid level.

<  Check for any leaks in the plumbing connections.

! Sample compartment

<  Check that the spill tray is in place underneath the Quick-Change Torch module.

< Inspect the purge window that fits into the ceramic purge extension. The window
should not be cloudy or dirty.

! Sample introduction system

< - Inspect the torch, glassware, and aerosol injector tube. The glassware should be
clean. Small amounts of deposits are acceptable in most cases. Also check for
signs of melting.

< Check that the RF coil is clean. This prevents arcing across the coils.

Leakage of air into any part of the torch, nebulizer or spray chamber may cause
ignition problems. Therefore, be sure to regularly check the following four items:

Be sure that all gas fittings to the torch are finger-tight.
Check that the nebulizer/end cap is tightly secured to the spray chamber.

Check that the sample capillary tubing is attached to the nebulizer sample inlet.
The tubing should be clean and in good condition.

Check that the drain fitting is secured on the spray chamber drain. A loose-fitting
drain can cause pressure leaks and consequent plasma instability.

! Peristaltic pump and tubing
< Check that the pump tubing is in good condition, has no flat spots, and is correctly
installed around the pump head.
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< Replace tubing daily.
< Check that the pump rollers are clan and can move freely.
!  Drains
< Check that the spray chamber drain is properly set up on the pump so that waste is
pumped out of the spray chamber. Replace the drain tubing if it has deteriorated.
< Check the spray chamber drain and the drain underneath the sample shelf lead to
the drain bottle. Empty the drain bottle if necessary. Dispose of waste properly.

! Autosampler

< Install the tray in the autosampler and place the wash beaker in the rear left of the
tray (location ).

< Check that the sampling probe is installed at the correct height and the probe
capillary is attached to the pump tubing for the sample.

! Printer
< Check that the printer has an adequate supply of paper to print your results.

9.5.2 Starting the Instrument and Accessories:
It is recommended that you leave the Main Instrument switch on even when the
instrument is not in use. If the Main Instrument switch is turned off, the system will
need to reinitialize when power is switched back on.

The RF Generator Standby switch may also be left on when the instrument is not in
use. It is only necessary to turn off this switch if you are replacing the RF coil.

To conserve the argon purge gas for the detectors, you can use the Auto
Shutdown/Startup feature. Automatic Shutdown is an alternative to turning off the
power to the main instrument, which also then shuts off the purge gas.

A. Starting up the instrument:

1. If you have not already done so, turn on the gases and the cooling water chiller.

2. If the Main Instrument switch has been turned off, turn it on.

3. Close the doors to the sample compartment. Be sure that the front door is fully
closed and secured.

40 of 78

WQL SOP: 505 ICP-OES Revision 03-August 14, 2006
CONTROLLED DOCUMENT  COPY NO. ()

DO NOT COPY DATE | /9 (1
QA ( 3%’




OFFICIAL DOCUMENT
SOP 505

Be sure to close and secure the doors to the sample
compartment before turning on or off the RF Generator
Standby switch.

4. Turn the RF Generator Standby switch on if it is not already on. With both the
Main Instrument and RF Generator switch on, the blue System Power light

goes on.
5. Turn on the autosampler if it is not already on.
B. Starting the Computer and Software
1. Switch on the computer, monitor, and printer.
2. For Window 95: click on the Start button. Select the ICP WinLab program.
3. Verify instrument configuration:

<  Check that the autosampler type and tray are correct.

< Check that the peristaltic pump and tubing type are correct.

< Check that the correct plasma viewing position is set. Change if required, using the
Change to Axial or Change to Radial commands in the System menu for the
desired position.

- C. Setting Up and Starting the Peristaltic Pump
! Setting up the peristaltic pump:
1. Check that the sample tubing and the drain tubing leading form the spray
chamber are properly set up on the pump.
2. If the pump tubing is new, gently stretch it. Position the clips on the tubing in
front of the tubing stops.
3. Replace the tubing clamps for each channel and swing the cam levers over to
apply tension to the clamps.
4. Start the pump before igniting the plasma to purge air out of the sample
capillary tubing.

! Starting the pump:

1. Place the sample capillary tubing in a container of a 1% nitric acid solution.

2. Display the Plasma Control window by clicking on the Plasma icon or by clicking
on Plasma Control in the Tools menu. Click on the Pump button to turn on the
pump.

3. Adjust the flow rate to 1mL/min. Before adjusting the rate, the Override Method

box must be checked.

4. If necessary, adjust the tension on the pump tubing, one channel at a time. For

the sample tubing, gradually tighten the adjustment screw until the liquid flows
smoothly without bubbles. The drain tubing should have a segmented flow of
liquid leading to the drain bottle. Bubbles in the drain tubing are normal.
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D. Igniting the Plasma

The process requires approximately 90 seconds. Argon gas flows through the
torch and spray chamber, purging the sample introduction system of air. With the
argon continuing to flow, power is applied to the RF coil. After the RF power has
ramped to approximately 1300 watts, a high voltage spark is injected into the argon
flow causing the argon to ionize. The free electrons that are created then interact
with the applied RF field to cause further argon ionization and for a plasma.

When vou ignite the plasma, be sure to observe it closely
through the viewing window. If the plasma is unstable,
immediately click the Plasma switch to OFF in the Plasma
Control window or press the red Emergency Plasma Off button
above the sample compartment.

1. Observe the following precautions when igniting the plasma:

2. If you have not yet started the pump, place the sample capillary tubing in a
container of 1%HNQO3. The pump automatically shuts off at the beginning of the
ignition sequence and is restarted at the end of the ignition sequence.

3. Click the Plasma switch to On in the Plasma Control window to turn on the

plasma. A successful ignition is indicated by a colored plasma icon
‘on the switch in the Plasma Control window. The yellow Plasma On light on the
front of the instrument will be on.

4. Immediately examine the plasma through the viewing window.

Note: During the ignition process, messages appear in the lower left corner of
the screen to inform you of the status. The first time the plasma is ignited, a
message reads Alnitial Purge= and the system counts down 75 seconds. This
message is followed by ASetting nebulizer flow=. After a AFinal Purge= of 15
seconds, the plasma is ignited. This is followed by a ASettling Time= of 15
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seconds to give the plasma time to stabilize. At the end of this process, a
message reads APlasma has ignited=.

E. Examining the Plasma:

After igniting the plasma, you must examine to determine whether it is stable or
unstable. A stable plasma will be situated just above the inner quarts tube in the
torch and will have a bright discharge of the shape as seen Figure 9.2. An
unstable plasma is indicated by a doughnut-shaped glow or discharge ring that
forms around the top of the torch.

! To proceed if the plasma is stable
1. Wait minimum of 45 minutes before running samples. This ensures accuracy in
your results, since it allows the temperature of the sample introduction system to
fully stabilize.
2. Proceed to Optimizing and Verifying Performance.

! To proceed if the plasma is unstable
1. Click the Plasma switch to Off in the Plasma Control window or press the red
- Emergency Plasma Off button located above the sample compartment.

A unstabte ptasma is usually caused by air leaking into the system.
this problem, do the following:

1. Check that the gas fittings on the torch are finger-tight.

2. If the fittings are properly tightened, then check the argon gas connections at
the back of the instrument.

3. Repeat the ignition procedure. Click the Plasma switch to On.

! Correcting Unsuccessful Ignition
If the plasma fails to ignite during the ignition sequence, the plasma switch will go
to the off position, indicating that ignition has failed but may be attempted again.
Check the following:

! Sampling technique

< Be sure you are using the correct sampling technique settings for your application.
Click on the Sampling button in the toolbar to display a dialog where you can select
the sampling technique with the proper plasma conditions.

! Ignitor
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< Open the doors to the sample compartment. Check that the ignitor cable is
plugged in.

! Air Leaks

< Anunstable plasma is usually caused by air leaking into any part of the torch,
nebulizer, or spray chamber. To correct check the following:
1. Check that the gas fittings on the torch are finger-tight. Do not over tighten
them.
2. If the gas fittings on the torch are properly tightened, check the argon gas
connections at the back of the instrument.

! Drain:

< Check that the fitting on the spray chamber drain is secure. Be sure that the pump
is properly draining the spray chamber and that the drain liquid is not backing up
into the spray chamber.

! Nebulizer end cap:
< Check that it is tightly secured to the spray chamber.

! Sample capillary and tubing:
< Check that one end is attached to the nebulizer and that the other end is immersed
in solution.

9.6 Optimizing and Verifying Performance:

9.6.1 Performing the Background Equivalent Concentration (BEC) Test:
In performing the BEC test, you determine what concentration of analyte is
equivalent to the plasma background at the analyte wavelength. This provides an
indication of the sensitivity of the instrument. To do the test you first perform a Hg
realign from the mnBEC work space. Second calibration by running a blank
followed by a standard. The calibration establishes the relation between emission
intensity and concentration. A calibration also takes into account the dark current
noise. Once the calibration is complete, you close the shutter, thereby blocking the
light from the plasma source form reaching the detector. At his point, you take a
reading (at Zero intensity). This extrapolates the calibration line backward until it
intercepts the concentration axis. The resulting concentration value is negative. By
changing the sign to positive, you obtain the BEC value. See Figure 9.3.

1. Check that the method you created for the performance tests is open. If not, in
the File menu, click on Open Method.
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2. Click on the Manual icon to open the Manual Analysis Control window,.
3. In the Manual Analysis Control window, select Print Log to disable, click on
the box to remove Save Log.
4. Aspirate the blank and click on Analyze Blank.
5. Aspirate the 1ppm manganese solution and click on Analyze Standard. This
completes the calibration.
6. Aspirate the rinse solution.
7. In the Tools menu, click on Spectrometer Control.
8. In the Spectrometer Control window, close the shutter by clicking on the
Shutter button. Check that the status of the Shutter changes to AClosed= in the
status display.
9. Click on the Manual Analysis Control window to bring it to the front.

10. While continuing to aspirate the rinse solution, click on Analyze Sample. This
will give you results in concentration units.

11. Click on the Spectrometer Control window to bring it to the front. Click on the
Shutter button to change the shutter from Closed to the Auto position, which
returns it to instrument control. Check that the status of the Shutter changes to
AAuto= in the status display.

12. By closing the Manual & Sprectual Control windows the results are sent to the
printer.

Check the results. By taking the negative value and making it a positive value,
this gives you the BEC. It should be less than or equal to 0.04 mg/L. Attempt a
second run, if it is not within required value refer to Troubleshooting section 11.

9.6.2 Performing the Precision Test:
The coefficient of variation (CV) test expresses the short-term precision for several
measurements for a strong emission line. This is often used as an indicator of
noise associated with sample introduction.

1. Check that the method you created for the performance tests is open.

2. If you have just run the BEC test, the Manual Analysis Control window should
be displayed. Click on the Manual icon.

3. In the Method Editor, check on the Spectrometer, Read Time, Replicates
page and specify 10 replicates if not already on file.

4. In the Manual Analysis Control window, disable Override Method to use the
Read Delay specified in the method. To disable it, click on the box to remove
the check mark.

5. Aspirate the 1 ppm manganese. Select autosampler position 160, specific
location for 1 ppm manganese.
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6. In the Manual Analysis Control window, click on Analyze Sample.
7. Close Manual window to send results to printer.
Check the results. The RSD should be less than 1.0%. Also attempt a second
run. If value is not acceptable refer to the Troubleshooting section 11.

9.6.3 Sodium bullet test:
This test allows you to visualize the sample flow in the plasma, so that you can
check that the sample introduction system is working correctly.
1. Aspirate a 1000 mg/L solution of sodium.

2. Examine the plasma through the viewing window in the sample compartment
door.

A yellow-orange bullet should be visible in the center of the discharge, and should
extend from the base of the discharge to about 2-3 mm above the top of the RF
coil. If the bullet height is unsatisfactory, adjust the nebulizer argon flow in the
Plasma Control windows.

If no bullet appears or the bullet is faint:
# Check that your sample does contain sodium at the required concentration.

# Check that sample is being pumped to the nebulizer.
# Check that the drain is being pumped property.
If the above checks fall, turn off the plasma, then check the following:
# Check that the nebulizer end camp is connected tightly.
# Check the nebulizer spray pattern.

# Check that the injector is not clogged.

9.6.4 Spectral Interference Check (SIC) Solutions:
When interelement corrections are applied, SIC solutions are needed containing
concentrations of the interfering elements at level that will provide an adequate test
of the correction factors. Use the following PE interference check standards:

1.) Interferents Alone---PEN930-0226
Method-dilute PEN930-0226 by a Factor of 10

Ca Mg Al Fe
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2.) Combination of interferents and analytes
Method-dilute 10ml of Interferant solution PEN930-0226 + 1ml of analyte
solution PEN930-0227 to 100ml with 5% HNO3.

Be Ba
Mn
v

3.) Alternate Interferant A
Method-10ml PEN930-0226 + 10ml PEN930-0228 and dilute to 100ml with 5%
HNOS3.

V Mn

4.) Solution of interferant and analytes
Method-10ml PEN930-0226 + 10ml PEN930-0228 + 1ml PEN930-0227 + tml

PEN930-0229 ditute to 100mlt
B Na Al Mo i
Ca Si
Fe Mg

Note: Record all data in Performance Logbook, calculate all %sRecoveries.
9.7 Sample Analysis:
9.7.1 Setting up the Autosample Tray:
Before arranging samples in the autosampler using the autosampler loading list
and/or anlyatical sequence; you must have entered all information for your samples
and solutions in your method and in the sample information file.
X To load samples and solutions in the autosampler using the Automated Analysis

Control window.
1. In the Automated Analysis Control window, click on the Analyze tab.
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2. In the Analysis menu, click on Analytical Sequence to see a list of the
locations of your samples and solutions. Print sequence on file. '
3. Load samples and solutions in an empty tray according to preselected
sequence.
4. Place each sample in autotray position corresponding to sequence on file.

X Toload samples and solutions in the autosampler when the Manual Analysis
window is open.
1. In the Analysis menu, click on Autosampler Loading List to see a list of the
locations of your samples and solutions.
2. Load samples and solutions in an empty tray.
3. In the Analysis menu, click on AS Controls Load Tray.
4. Place each sample in autotray position corresponding to sequence on file.
5. Click on Go to Wash Loc. In the Manual Analysis Control window.

9.7.2 To perform automated analyses:
< See the following steps:

Step What it does

Examining the Analytical Before analyzing samples, check the
Sequence sequence and make any changes.
Calibrating and Analyzing Solutions and samples are analyzed. A
Samples calibration is performed according to

specifications.

Stopping and Restarting During the analysis, you may need to stop
operations and restart the analysis.

Analyzing Additional If you have completed an analysis and need to

Samples analyze additional samples.

9.7.3 Examining the Analytical Sequence:
Examine the analytical sequence before analyzing samples.
1. In the Analysis menu, click on Analytical Sequence. Verify that your
sequence is correct. K it is correct, skip steps 2 and 3 below.
2. To make changes to the sequence for unknown samples, QC samples, and
matrix check samples, go to the Sample Information Editor and make the
changes in the Sample Information file.
3. To make changes to the sequence for calibration solutions, go to the Method
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Editor Calib.
4. To analyze a selected group of samples that are a subset of samples in the
sample information file, type the locations on the Automated Analysis Control
window.

9.7.4 Calibrating and Analyzing Samples:
According to your calibration choices, select the appropriate steps below. All
controls (Analyze All, Calibrate, and Analyze Samples) are located on the
Automated Analysis Control Analyze page. You select the calibration parameters
in the Method Editor Calib pages and view the calibration curves in the Calibration
Display window or view calibration data in the Results Display window.

A. Calibrating

Select a calibration option and analyze mode

To do this: Use this:

To generate a new calibration Click on Analyze All.

and continue with samples
(overrides Initial Calib page
of the Method Editor)

To generate a new calibration, Click on Calibrate. Examine the
examine it, and continue calibration and recalibrate if desired.
with samples When ready click on Analyze Samples.
To recalibrate Click on Calibrate

To analyze samples when a Click on Analyze Samples to analyze
calibration is automatically samples using this calibration.

recalled with the method (as
directed on the Initial Calib
page of the Method Editor)

To manually recall a In the Analysis menu, click on Recall
calibration and then analyze Calibration... Select the results data

samples set that contains the desired calibration.
- Then, click on Analyze Samples.

B. Stopping and Restarting
When you stop an analysis, the autosampler probe does not automatically go back
to the wash, but remains where you stopped it.
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Select stop and restart options from the following:

To do this:
To stop an analysis

To change Set Up
Option after an analysis
has begun.

To restart analysis from
a selected solution

To restart an analysis
from beginning

OFFICIAL DOCUMENT
SOP 505

Use these steps:

1. In the Automated Analysis Control
window Analyze page, click on the
button that you used to start the
analysis, press F8 (Cancel), or select
Cancel Analysis... from the Analysis
menu.

2. In the Stopping and Analytical
Sequence dialog, select the option that
indicates how you want to stop.

1. Stop the analysis as described
above.
2. Click on the tab for the Set Up page

3. Change set up options. You can
select whether or not to save data, print
a log of the results, or perform an auto
wavelength realign. You can also
program an automatic shutdown.

1. In the Automated Analysis Control
window, click on the button that you
originally used to start the analysis.

2. In the Continuing an Analytical
Sequence dialog, select where you want
the analysis to continue.

In the Automated Analysis Control
window, from the click on Reset and
then on a button (Analyze All,
Calibrate, or Analyze Samples) the
starts an analysis.

C. Analyzing Additional Samples:

If you have completed an analysis using an autosampler and need to analyze
some additional samples, use the following procedure.
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For automated analyses using the Automated Analysis Control Window:
1. Open the method you were previously using in the Method Editor window (if it is
not already open). Click on the Calib tab in the Method Editor. Remove the
calibration blank and all calibration standards listed on the Ids and Location
page. To remove then, you must click on the row label to select the entire row.
Then, in the Edit menu, click on Clear.
2. Click on the Initial Calib, Special Options tab (also in the Calib section of the
method). Select the option for Use calibration curves from previous method.
3. Save the method under a different name. This will keep the original method
intact. In the File menu, click on Save As... Method. Type a name for the new
method.
4. In the Automated Analysis Control window, remove the methods that are
currently listed. Enter the name of the new method you just created.
5. Select the autosampler locations for the additional samples that you want to
analyze.
6. Click on the Analyze tab in the Automated Analysis Control window.
7. Click on Analyze All.

Note: The system will use the calibration from the previous method and analyze
the additional samples.

9.8 Expression of Data:

9.8.1 Generating Reports:
If you saved data in a Results data set (as requested in an analysis control
window), you can use the WinLab Reported to generate reports.

A. To start the WinLab Reporter:
< Inthe File menu, click on Utilities... Reported.

B. To start the WinLab Library Manager:

Achrive result data sets on a routine basis to avoid filling up space on the hard disk
and potentially slowing down instrument operation. Library maintenance
procedures include archiving, deleting, and packing data sets. Exit software and
enter thru Optima 3000 file, click on Libman icon.

9.8.2 Laboratory Information Management System (LIMS):
All laboratory data is entered via the SQLLIMS system as discussed in the Policy
and Procedure Manual section 4.0. Laboratory analysts are responsible for the
data and result entry of the data they produce each day.
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When available the result entry using ARE will be used for instrument generated
data. When this system is not available manual data entry will be used.

9.8.3 Reporting MDL's- See Attachment for all current metals MDLS's:
See Attachment 1.1 section 1 for all current MDL=s.

9.8.4 Result Approval and Verification:
Result approval is performed at the TASK level only. First stamp will be the analyst
who performed the test and this analyst will enter data. A second analyst other than
the analyst entering the data will verify and approve all data. Verification will be
done 7 days from entry of data. Data out of QA/QC requirements supervisor must
approve data prior to entry.

9.8.5 Changes in Data :
Changes in data will be performed at the TASK level only. All changes in LIMS
must be performed by supervisor level only.

9.9 Shut Down:
There are two ways to extinguish the ptasma. You can extinguish the ptasma
manually or you can extinguish it automatically using Automatic Shutdown.
A. To automatically extinguish the plasma and put the spectrometer on
standby:
If you have selected Automatic Shutdown and indicated how you want the system
to shut down, the system will automatically shut down and flush the sample
introduction system. The system next extinguishes the plasma and puts the
spectrometer into standby if that option was selected. The software remains on.
B. To manually extinguish the plasma:
1. Flush the sample introduction system for five minutes with the plasma on.
During this five minutes, if you analyzed aqueous solutions, flush with 1%
HNO3.
2. Extinguish the plasma by clicking on the Plasma Off switch in the Plasma
Control Window.
C. To manually put the spectrometer on standby:
1. In the System menu, click on Auto Startup/Shutdown.
2. In the dialog, select Shutdown enabled... and immediately on OK. Be sure
Put Spectrometer into Standby is selected.
3. If the plasma has already been extinguished, be sure that the Wash option is
not selected and that Turn off Plasma and Pump is not selected.
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